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Who This Book Is For
This book is for the reader who has never used this 
particular technology or software application. It is 
also for readers who want to expand their knowledge.

The Conventions in This Book
1	 Steps

This book uses a step‐by‐step format to guide you 
easily through each task. Numbered steps are actions 
you must do; bulleted steps clarify a point, step, or 
optional feature; and indented steps give you the 
result.

2	 Notes
Notes give additional information — special 
conditions that may occur during an operation, a 
situation that you want to avoid, or a cross‐reference 
to a related area of the book.

3	 Icons and Buttons
Icons and buttons show you exactly what you need to 
click to perform a step.

4	 Tips
Tips offer additional information, including warnings 
and shortcuts.

5	 Bold
Bold type shows command names, options, and text 
or numbers you must type.

6	 Italics
Italic type introduces and defines a new term.

How to Use This Book
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CHAPTER  1

Getting Started 
with Excel
You use Microsoft Excel to create spreadsheets, which are documents that 
enable you to manipulate numbers and formulas to quickly create powerful 
mathematical, financial, and statistical models. In this chapter you get some 
background about Excel, learn how to access the desktop and online versions 
of the program, and take a tour of the program’s features.
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Build a Spreadsheet

Getting to Know Excel

Working with Excel involves two basic tasks: building a spreadsheet and then manipulating the 
data on the spreadsheet. Building a spreadsheet involves adding data such as numbers and 

text, creating formulas that run calculations, and adding functions that perform specific tasks. 
Manipulating spreadsheet data involves calculating totals, adding data series, organizing data into 
tables, and visualizing data with charts.

This section gives you an overview of these tasks. You learn about each task in greater detail as you 
work through the book.

Add Data
You can insert numbers, text, and other characters into any 
cell in the spreadsheet. Click the cell that you want to 
work with and then type your data. Your typing appears in 
the cell that you selected, as well as in the formula bar, 
which is the large text box above the column letters. When 
you are done, press Enter. To edit existing cell data, click 
the cell and then edit the text in the formula bar.

Add a Formula
A formula is a collection of numbers, cell addresses, and 
mathematical operators that performs a calculation. In Excel, 
you enter a formula in a cell by typing an equal sign (=) and 
then the formula text. For example, the formula =B1 – B2 
subtracts the value in cell B2 from the value in cell B1.

Add a Function
A function is a predefined formula that performs a specific task. For example, 
the AVERAGE function calculates the average of a list of numbers, and the 
PMT function calculates a loan or mortgage payment. You can use functions 
on their own, preceded by =, or as part of a larger formula. Click Insert 
Function ( ) to see a list of the available functions.
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1Getting Started with Excel

Manipulate Data

Calculate Totals Quickly
If you just need a quick sum of a list of numbers, click a cell 
below the numbers and then click the Sum button ( ), 
which is available in the Home tab of the Excel Ribbon. You 
can also select the cells that you want to sum, and their 
total appears in the status bar.

Fill a Series
Excel enables you to save time by completing a series of values automatically. For 
example, if you need to enter the numbers 1 to 100 in consecutive cells, you can enter 
just the first few numbers, select the cells, and then click and drag the lower‐right 
corner to fill in the rest of the numbers. With Excel you can also fill in dates, as well as 
the names for weekdays and months.

Manage Tables
The row‐and‐column format of a 
spreadsheet makes Excel suitable for 
simple databases called tables. Each 
column becomes a field in the table, and 
each row is a record. You can sort the 
records, filter the records to show only 
certain values, and add subtotals.

Add a Chart
A chart is a graphic representation of spreadsheet data. As 
the data in the spreadsheet changes, the chart automatically 
changes to reflect the new numbers. Excel offers a wide variety 
of charts, including bar charts, line charts, and pie charts.
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1	 Click Start ( ).

Start Excel on the Desktop

Before you can perform tasks such as adding data and building formulas, you must first start the 
desktop version of Excel. This brings the Excel window onto the Windows desktop, and you can 

then begin using the program. In this section, you learn how to start Excel in Windows 11, but the 
steps are similar if you are using Windows 10.

This task assumes that you have already installed Excel 365 on your computer. If you prefer to use 
Excel on the web, see the next section, “Navigate to Excel for the Web.”

Start Excel on the Desktop

The Start menu appears.

2	 Click Excel.

The Microsoft Excel window 
appears on the desktop.

Note: Click Blank workbook to open 
a new Excel file.
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1Navigate to Excel for the Web

Navigate to Excel for the Web

If you want to work with Excel online instead of on the desktop, you need to know how to use your 
web browser to navigate to the Excel for the web version of the program.

With your Microsoft 365 subscription, you get access to both the desktop and online versions of each 
app, including Excel. This book uses the desktop version of Excel for its example screens. Fortunately, 
Excel for the web uses the same layout as the desktop version and offers mostly the same features, 
so everything you learn in this book applies to Excel for the web.

1	 Click Start.

The Start menu appears.

2	 Click Edge.

	A	 If you have Edge pinned to the Windows taskbar, click the 
Edge icon ( ) instead of following steps 1 and 2.

The Microsoft Edge web browser window appears.

Note: If you prefer to use a different web browser, start that 
browser instead of Edge.

3	 In the address bar, type www.office.com/launch/excel and 
press .

4	 If prompted, enter your Microsoft 365 username and 
password (not shown).

The Excel for the web app appears.

Note: Click New blank workbook to open a new Excel file.

https://www.office.com/launch/excel
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To get up to speed quickly with Excel, it helps to understand the various elements of the Excel 
window. These include standard window elements such as the title bar, window controls, and 

status bar; Office‐specific elements such as the Ribbon and File tab; and Excel‐specific elements 
such as the worksheet.

If you are using Excel for the web, note that the window you see is nearly identical to the Excel desktop 
window. The main exception is that, by default, Excel for the web displays a simplified version of the 
Ribbon.

Tour the Excel Window

A	 Title Bar
The title bar displays the 
name of the current 
workbook.

B	 Ribbon Tabs
You use these controls to 
display different sets of 
Ribbon commands.

C	 Ribbon
This area gives you 
access to all the Excel 
commands, options, and 
features. To learn how to 
use this element, see the 
following section, “Work 
with the Excel Ribbon.”

D	 Workbook Window Controls
You use these controls to minimize, maximize, restore, and close the current workbook window.

E	 File Tab
Click this tab to access file‐related commands, such as Save and Open.

F	 Worksheet
This area displays the current worksheet, and it is where you will do most of your Excel work.

G	 Status Bar
This area displays messages about the current status of Excel, the results of certain operations, and other 
information.
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	A	 Each tab is organized into groups 
of related controls.

	B	 In many groups you can click the 
dialog box launcher button ( ) 
to display a dialog box that 
contains group settings.

2	 Click the control for the feature.

	C	 If the control displays a list of 
options, click the option you 
want.

Excel runs the command or sets 
the option.

Note: By default, Excel for the web 
displays a simplified Ribbon. To see 
the full Ribbon, click the Switch 
Ribbon icon ( ) on the far right of 
the simplified Ribbon.

1	 Click the tab that contains the 
Excel feature you want to work 
with.

Excel displays the controls in 
the tab.

Work with the Excel Ribbon

You use the Ribbon to access all the features, commands, and options in Excel. The Ribbon is 
organized into tabs, such as Home, Insert, and Page Layout, and each tab contains a collection 

of related controls. For example, the Insert tab contains controls related to inserting objects into a 
worksheet, while the Formulas tab contains controls related to building formulas. Each tab usually 
includes buttons, lists, and check boxes.

The File tab is a bit different because it displays the Backstage view, which contains controls related 
to working with Excel files, such as opening, saving, and printing them.

Work with the Excel Ribbon



CHAPTER  2

Entering Data
Are you ready to start building a spreadsheet? To create a spreadsheet in 
Excel, you must know how to enter data into the worksheet cells, and how 
to edit that data to fix typos, adjust information, and remove data you no 
longer need.
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Learning the Layout of a Worksheet

In Excel, a spreadsheet file is called a workbook, and each workbook consists of one or more 
worksheets. These worksheets are where you enter your data and formulas, so you need to know 

the layout of a typical worksheet.

In particular, you need to know that worksheets are laid out in rows and columns, that a cell is the 
intersection of a row and column that has its own unique address, and that a range is a collection of 
cells. You also need to be familiar with worksheet tabs and the Excel mouse pointer.

A	 Cell
A cell is a box in which you enter 
your spreadsheet data.

B	 Column
A column is a vertical line of cells. 
Each column has a unique letter 
that identifies it. For example, the 
leftmost column is A, and the 
next column is B.

C	 Row
A row is a horizontal line of cells. 
Each row has a unique number 
that identifies it. For example, the 
topmost row is 1, and the next row is 2.

D	 Cell Address
Each cell has its own address, which is determined by the letter and number of the intersecting column and 
row. For example, the cell at the intersection of column C and row 10 has the address C10.

E	 Range
A range is a rectangular grouping of two or more cells. The range is indicated by the address of the top‐left 
cell and the address of the bottom‐right cell. H11:K15 is an example of a range of cells, and it refers to all 
the cells within the rectangle from column H, row 11 to column K, row 15.

F	 Worksheet Tab
The worksheet tab displays the worksheet name. Most workbooks contain multiple worksheets, and you use 
the tabs to navigate between the worksheets.

G	 Mouse Pointer
Use the Excel mouse pointer ( ) to select cells.
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You might think that Excel would accept only numeric input, but it is actually much more flexible 

than that. So, to build a spreadsheet in Excel, you should understand the different types of data 
that Excel accepts. There are three main types of data that you can enter into a cell: text, numbers, 
and dates and times. Excel places no restrictions on where or how often you can enter these types of 
data on a worksheet.

Understanding the Types of Data You Can Use

Text
Text entries can include any combination of letters, symbols, and numbers. 
You will mostly use text to describe the contents of your worksheets. This is 
very important because even a modest‐sized spreadsheet can become a 
confusing jumble of numbers without some kind of text guidelines to keep 
things straight. Most text entries are usually labels such as Sales or Territory 
that make a worksheet easier to read. However, text entries can also be text 
or number combinations for items such as phone numbers and account codes.

Numbers
Numbers are the most common type of Excel data. The numbers you enter 
into a cell can be dollar values, weights, interest rates, temperatures, or any 
other numerical quantity. In most cases you just type the number that you 
want to appear in the cell. However, you can also precede a number with a 
dollar sign ($) or other currency symbol to indicate a monetary value, or 
follow a number with a percent sign (%) to indicate a percentage value.

Dates and Times
Date entries appear in spreadsheets that include dated information, such as 
invoices and sales. You can either type out the full date (such as August 23, 
2023) or use either the forward slash (/) or the hyphen (‐) as a date separator 
(such as 8/23/2023 or 8‐23‐2023). Note that the order in which you enter 
the date values depends on your regional settings. For example, in the United 
States the format is month/day/year. For time values, you use a colon (:) as a 
time separator, followed by either a.m. or p.m., such as 9:15 a.m.
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1	 Click the cell in which you 
want to enter the text.

	A	 Excel marks the current cell 
by surrounding it with a 
thick, green border.

Enter Text into a Cell

Your first step when building a spreadsheet is usually to enter the text data that defines the 
spreadsheet’s labels or headings. Most labels appear in the cell to the right or above where the data 

will appear, whereas most headings appear above a column of data or to the left of a row of data.

Note, however, that you do not have to use text for just labels and headings. You can also enter 
text as data, such as a database of book or movie names. You can also write short notes that explain 
sections of the worksheet, and add reminders to yourself or others about missing data or other 
worksheet to‐do items.

Enter Text into a Cell

2	 Start typing your text.

	B	 Excel opens the cell for 
editing and displays the 
text as you type.

	C	 Your typing also appears in 
the formula bar.

Note: Rather than typing the 
text directly into the cell, you 
can also type the text into the 
formula bar.
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	E	 Excel closes the cell for editing.

	F	 If you pressed , Excel 
moves the selection to the cell 
below.

	G	 If your text is longer than the 
cell width, Excel either extends 
the text into the cell to the 
right (if that cell is empty, as 
shown here) or temporarily 
truncates the display of the text 
(if the cell to the right is not 
empty). To learn how to widen a 
column, see Chapter 5.

3	 When your text entry is complete, 
press .

	D	 If you do not want Excel to move 
the selection, you can instead 
either click Enter ( ) or press 

 +  .

TIPS
When I press Enter, the selection moves to 
the next cell down. Can I make the 
selection move to the right instead?
Yes. When you have finished adding the data 
to the cell, press . This tells Excel to close 
the current cell for editing and move the 
selection to the next cell on the right. If you 
prefer to move left instead, press ; if you 
prefer to move up, press .

When I start typing text into a cell, why does Excel 
sometimes display the text from another cell?
This is part of an Excel feature called AutoComplete. If the 
letters you type at the start of a cell match the contents 
of another cell in the same column, Excel fills in the full 
text from the other cell under the assumption that you are 
repeating the text in the new cell. If you want to use the 
text, click  or press ; otherwise, just keep typing 
your text.
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1	 Click the cell in which you want 
to enter the number.

	A	 Excel marks the current cell by 
surrounding it with a thick, green 
border.

Enter a Number into a Cell

Excel’s forte is crunching numbers, so most of your worksheets will include numeric values. Although 
you will often use numbers by themselves as part of a database or table, many of the numbers you 

enter will be used as the inputs for the formulas you build, as described in Chapter 6.

You can enter whole numbers (such as 5 or 1,024), decimals (such as 0.25 or 3.14), negative numbers 
(such as –10 or –6.2), percentages (such as 6% or 25.9%), and currency values (such as $0.25 or 
$24.99). To get the most out of Excel, you need to know how to enter these numeric values.

Enter a Number into a Cell

2	 Start typing your number.

	B	 Excel opens the cell for editing 
and displays the number as 
you type.

	C	 Your typing also appears in the 
formula bar.

Note: Rather than typing the number 
directly into the cell, you can also 
type the number into the formula bar.


